******************Start of Oracle Application User Guide Notes*****************
Oracle Application Developer Notes :-

1. Duplicating Data from the previous Record
To copy a field value from the previous record:

1. Enter a new record or query an existing record in your form.

2. Navigate to the field whose value you want to duplicate in the new record.

3. Choose Duplicate, Field Above from the Edit menu to copy the field value from the previous record to the current record.

To copy all field values from the previous record (when available):

1. Enter a new record or query an existing record in your form.

2. Choose New from the File menu to insert a new record after the existing record.

3. Choose Duplicate, Record Above from the Edit menu.

Attention: If your current block requires all records to be unique, the Duplicate Record Above menu item may not duplicate those fields that must be unique. Also, the Duplicate, Field Above and Duplicate, Record Above menu items are not available if there is no previous record, that is, if you are currently on the first record of a block.
2. To learn about the current record:

Choose Record History from the Help menu.

(Created By, Creation Date, Table Name, Update By, Update Date)

3. Flexfield :-

A flexfield is a flexible data field that your organization can customize to your business needs without programming. Oracle Applications uses two types of flexfields, key flexfields and descriptive flexfields.

Key Flexfield :- A key flexfield is a field made up of segments, where each segment has both a value and a  meaning. You can think of a key flexfield as an “intelligent” field that your business can use to store information represented as “codes.”

A combination of segment values, also known as a key flexfield code combination, uniquely describes a business entity stored in a key flexfield.

Descriptive Flexfield :-

Your organization can use descriptive flexfields to capture additional information that is important and unique to your business.

Each segment in a descriptive flexfield window has a name, and can have a set of valid values.

Range Flexfield :-

A range flexfield is a variation of a key flexfield that allows you to input a low and a high combination of segment values so that you can express a range of key flexfield combinations.

4. Definitions :-

a) Concurrent Program  :- A concurrent program is a program that does not require continued  interaction on your part to perform a specific task.

b) Concurrent Process    :- A concurrent process is an instance of a running concurrent program.
c) Concurrent Request   :- A concurrent request is a request that you submit to run a concurrent program as a concurrent process.
d) Concurrent Manager :-A concurrent manager is a component of concurrent processing that monitors and runs tasks without tying up your computer.
e) Concurrent Manager :- A concurrent manager is a component of concurrent processing that monitors and runs tasks without tying up your computer.

f) Request Set :-A request set is a collection of reports and/or programs that you group together. You can submit the reports and/or programs in a request set all at once using a single transaction.

g) Background Processing :- You use your Oracle Applications windows to submit all your concurrent requests. Once your request is submitted, the concurrent managers immediately take over, and complete the task with no further involvement from you.
h) Scheduling

Using Standard Request Submission, you can define schedules to automatically resubmit your program, report, or request set. At submission time, you can specify:

· the starting date and time

· the time of day for resubmission

· the resubmission interval in months, days, hours, or minutes from either the start or completion of the request

· the date and time to stop repeating the program, report, or request set

· day or days of the week or month to resubmit Oracle Applications automatically resubmits the program, report, or request set until the end date.

Notes :-

1. View ( Request

Select the Request to be run

1. At these Times Frame ( Click Schedule Button
a) Run the Job

b) Once  (Will ask for Run at {Where U enter the date along with time stamp} )

c) Periodically 

Ca) Start at, End at (Data along with time stamp)

Cb) Re-run Every (Minute, Hour, Day, Week, Month)

d) On Specific Days

Da) Start at, End at (Data along with time stamp)

Db) Dates of every month

Dc) Days of Every Week

Steps to Submit a Request :-

1. Choose to submit a single request or a set of requests

2. Enter the Request Information

3. If the Request contains Parameters, then supply them

4. If you want to schedule this request, then Define Submission Rule

5. If you want to set the printer options or notify the following people, then Define Completion Options

6. Then Select Submit Button

7. Oracle Appls. Records The Request Id.

Till Page No. 167 Completed

Next step is “Defining Request Sets”

Define Request Sets :-

· By defining request sets, you can submit the same set of requests regularly using a single transaction.

· You use the Request Set window to create and edit request sets. 

· Alternatively, you can use the Request Set wizard to create simple request sets.

Steps to define a Request Set :-

1. Enter request set name and other general information

2. Define a Stage

3. Enter Request for Stage

4. Enter Request Parameters

5. Repeat Step 2 to 4 by defining several Stages

6. Link Stages

7. Save Changes

Organizing Requests with Stages :-

Request sets are divided into one or more ”stages” which are linked to determine the sequence in which your requests are run. Each stage consists of one or more requests that you want to run in parallel (at the same time in any order).

For example, in the simplest request set structure, all requests are assigned to one stage.


Request Set



( Stage 1




( Request 1




( Request 2




( Request 3




( End

To run requests in sequence, you assign requests to different stages, and then link the stages in the order you want the requests to run.


Request Set



( Stage1

( Stage 2

( Stage 3




( Request 1

( Request 2

( Request 3
( End

Notes :- The concurrent manager allows only one stage in a request set to run at a time. When one stage is complete the following stage is submitted. 

A stage is not considered to be complete until all of the requests in the stage are complete. One advantage of using stages is the ability to run several requests in parallel and then move sequentially to the next stage. 

This allows for a more versatile and efficient request set.

Notes :- Every Stage in a Request Set has Status. (Success, Warning or Error).

In a Request Set, the status of all the stages should be either Success or Warning, by it should not return an error.

Run in Parallel :- Creates one stage containing all of the requests you wish to run in parallel.

Run Sequentially  :- Creates a separate stage containing the request or requests for each step in the sequence and link in the appropriate order. 

Run Sequentially but abort on Error :- Sets up your sequence the same as it did for Run Sequentially, but when it links the stages, it does not enter a follow up stage as a link in the Error completion status field.

Steps to Create a Request Set through Wizard :-

1. Responsibility : SYSADMIN

2. Requests ( Set
As U find the below picture.
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3. Select the Request Set Wizard Button. 

[image: image2.png]Oracle Applications - [SSW] Vision Corporation Port 8032 MEIE

¢ Touls Window Help ORACLE

Eile Edit View Fal

Functions | Documents

Requests:Set

Administer request sets

Security Top Ten Lis

Concurrent
Profile
Application
Install

(BB Reauest SetWizard

The Request Set Wizard can be used to quickly create a new.
Request Set in which all of the requests run sequentially, or all of
the requests run in parallel.

How would you like the requests in your new set to run?

Ggequentially (One After Another)
®n Barallel (All At Once)

|
Record: 11 [ | <osc> )





4. Select the radio button “Sequentially (One After Another)” and Click on Next Button.

[image: image3.png]Oracle Applications - [SSW] Vision Corporation Port 8032 MEIE

¢ Touls Window Help ORACLE

Eile Edit View Fal

Functions | Documents
Requests:Set

Administer request sets

Security Top Ten Lis

Concurrent
Profile
Application
Install

£ 7X

(B Reauest Setwizard

App
Des

Please choose a name and an application for your request set.

S Requestset!

LS My Request Set!

Active

|
Record: 11 [ | <osc> )





5. Once U Click Next, U will get a screen, where U need to define your programs in sequence to be 

executed.

Steps to Create a Request Set Manually :-

1. 
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2. Choose Define Stages or Link Stages (if Stages are already Defined to Link them).
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3. Click on Requests to define your requests under that Stage.
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4. If You any parameters for any program, U can see them in Parameters Screens by clicking the Parameters Button and also U can set the values.
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5. Steps to run a Request Set :-

a) View ( Requests ( Submit a New Request ( Request Set (Radio Button)
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7.
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End of Request Sets.

Working with Attachments :-

ToDo’s :-

1. Attach a Document to a Oracle Applications Record

2. View an Attachment

3. Copy or Delete an Attachment

To attach a new document to an Oracle Applications record:

1. In an application window, query or enter a data record.

2. Choose the Attachment toolbar icon. The Attachments window opens.

3. Enter a category, a description, and a data type.

4. Type in your document text, or specify a file name or web page URL.

4. Save your work.

To attach an existing document to an Oracle Applications record:

1. In an application window, query or enter a data record.

2. Choose the Attachment toolbar icon. The Attachments window opens.

3. Choose the Document Catalog... button. The Document Catalog window opens.

4. Query an existing document.

5. Check one or more documents.

6. Choose the Attach (number of documents) button.

7. Save your work.
User Profiles :- A user profile is a collection of changeable options that affect the way your applications run. Oracle Applications establishes a value for each option in a user’s profile when the user logs on or changes responsibility.

User profile options can be set at one or more of four levels: Site, Application, Responsibility, and User. Your system administrator can set default option values at any of these levels.

User Profile Hierarchy :- 

1. Oracle Applications treats user profile levels as a hierarchy, where User is the highest level of the hierarchy, followed by Responsibility, Application, and at the lowest level, Site.

2. Each user profile option ordinarily exists at each level.

3. For example, Oracle Applications provides a Site–level Printer option, an Application–level Printer option, and so on. Oracle Applications enforces the level hierarchy to ensure that a higher–level option value overrides a lower–level value.

For example, if your Site–level Printer value is “New York”, but your User–level Printer value is “Boston”, you can be assured that your reports print to the Boston printer.

Site Level :- Site is the lowest profile level. Site–level option values affect the way all applications run at a given installation site.

Application Level :- Application is the profile level immediately above Site. Application–level option values affect the way a given application runs.

Responsibility Level :- Responsibility is the profile level immediately above Application. Responsibility–level option values affect the way applications run for all users of a given responsibility.

User Level :- User is the highest profile level and is immediately above Responsibility. User–level option values affect the way applications run for a given application user.

************************End of Oracle Application User Guide*****************************

